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About this manual

Preface
This documentation describes the installation of Natural Engineer on Windows. This also
includes the installation of related products such as Natural Engineer Web Interface.
Natural Engineer is installed using the Software AG Installer, which you download from the
Software AG Empower website at https://empower.softwareag.com/.
This documentation provides product-specific instructions for installing Natural Engineer. It is
intended for use with Using the Software AG Installer. That guide explains how to prepare your
machine to use the Software AG Installer, and how to use the Software AG Installer and
Software AG Uninstaller to install and uninstall your products. The most up-to-date version of
Using the Software AG Installer is always available at http://documentation.softwareag.com/
(Empower login required).
This documentation is organized under the following headings:
What Can be Installed With Natural
Engineer?

General information on Natural Engineer and the
components that can be installed with Natural Engineer and
on the required license files.

System Requirements

Supported operating system platforms and prerequisites.

Important Information

Important information that you should be aware of before
you start the installation.

Installing Natural Engineer

How to install Natural Engineer with the Software AG
Installer.

Completing the Installation

How to proceed after the installation.

Operational Considerations

Information on configuring Natural Engineer.

Natural Engineer Web Interface

General Information on the Natural Engineer Web Interface.

Uninstalling Natural Engineer

How to uninstall Natural Engineer.

For important last-minute information, see the readme file that is provided with Natural
Engineer. You can find it in the Natural Engineer product documentation at
http://documentation.softwareag.com/ (Empower login required), or when you have chosen to
download the documentation during the installation of Natural Engineer - in a central directory
named _documentation in your main installation directory.
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What Can be Installed With Natural Engineer?

Natural Engineer
This is the full development version of Natural Engineer.

Natural Engineer Web Interface
The Natural Engineer Web Interface is a web based application that accesses the Natural
Engineer repository. Two configuration options are available; a multi user install where
clients access a common Natural Engineer repository or a single user install where the
Natural Engineer repository is on the client machine. A multi user environment uses a web
server (IIS or Apache) and can use either EntireX or NAS to execute the Natural Engineer
Natural objects.

License Files
During the installation of Natural Engineer, the Software AG Installer prompts you to enter
the path to one or more valid license files. The license file is an XML file which is delivered by
e-mail.
Separate license files are required for the following products and components:
■

Natural Engineer

■

Natural Engineer Advanced Services

■

Natural Engineer Aris Interface

Notes:
1. The Software AG Installer does not check all information in the license file. All license
checks are done, however, when the product itself is started.
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System Requirements

Supported Operating System Platforms
Natural Engineer supports the following 64-bit operating system platforms, both for the
Natural Engineer environment and the Natural Engineer Web Interface.
■

Microsoft Windows 7

■

Microsoft Windows 8

■

Microsoft Windows Server 2008

■

Microsoft Windows Server 2008 R2

■

Microsoft Windows Server 2012

Home Editions of Microsoft Windows are not supported.

Installation Prerequisites
Before installing Natural Engineer, the following must already be installed on your PC:
■
■

Windows 7, Windows 8, Windows 2008 Server or Windows 2012 Server.
Natural version 8.3.4 or above.
Any Natural Source should be saved with Line Numbers so that Natural Engineer can tie
up any potential modification with the Natural Source.

■

Adabas version 6.3 or above.

■

A Web Browser e.g., Microsoft Internet Explorer or Google Chrome

■

Microsoft Visio 2010 or above (optional).
If Microsoft Visio 2010 is to be used, it is essential that the VBA (Visual Basic for
Applications) option is included during the install. This option is part of the installation
options on the Microsoft Visio 2010 CD.

■

Microsoft Office Professional Edition 2010 or above (optional).
Microsoft Office Word 2010 or above (optional).
If you wish to make use of the report display option ‘Word’, you will need to have either
Microsoft Office Professional Edition 2010 or stand-alone Microsoft Office Word 2010
installed. These provide the necessary support for XML documents required for this
option.

■

PDF Generation (optional).
If you wish to generate reports to PDF then a Formatting Objects Processor e.g., Apache
FOP 1.1 and the Microsoft Command Line Transformation Utility (MSXSL.EXE) will need
to be installed. Configuration details can be found in the Natural Engineer
Administration Guide for Windows.

In addition please ensure that the latest Java runtime (version 1.7 or above) is installed.
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Natural Security
If you are using Natural Security, then the following steps need to be applied to ensure
successful installation and subsequent execution of Natural Engineer.
Note: The Natural Security settings described here are applicable to Natural
8.3 for Open Systems. The same principles can be applied to Natural 8.3
for Mainframes when using remote development environment.
Natural Parameter file: NATPARM
This is the default Natural Parameter file used by Natural.
Set the following parameters:
· USER - applicable User-id (For example DBA)
· AUTO - set on
Natural Security: Library Maintenance
Pre-define the following libraries prior to installation:
Library Id
HOSPITAL
SYSNEE
SYSNEEI

Library Name
Natural Engineer Sample Library
Natural Engineer
Natural Engineer Web Interface

Notes
1: When adding each of these libraries, set the General Options parameter:
People-protected = N
2: For the SYSNEE library, additionally set the Transactions parameters:
Startup
= NATENG
Batch execution = N
Natural Security: Utility Maintenance
For the utility SYSOBJH, set the following profile settings:
· All functions for Unload, Load and Delete should be set to 'A' (Allowed).
· General option parameter:
Transfer only = N
Natural Security: User Maintenance
For the User- id set up in the NATPARM above, set the Libraries parameter:
Default = SYSTEM
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Microsoft Excel
If you intend to use Microsoft Excel to display the reports generated by Natural
Engineer then please ensure that macros are enabled within Microsoft Excel.

Screen Resolution
It is recommended that Natural Engineer is run with a minimum screen resolution
of 1280x1024 with small fonts.

6

Installation

3
■
■
■
■
■

Important Information

Administrator Status ................................................................................................................................ 8
Installation Directory ............................................................................................................................... 8
Side-by-Side Installations ......................................................................................................................... 8
Upgrading Your Natural Engineer Environment............................................................................................ 9
Updating Your Natural Engineer Environment ............................................................................................. 9

7

Important Information

Administrator Status
The person performing the installation must have administrator rights.

Installation Directory
During the installation, you are asked to specify an installation directory. Specify the
installation directory in which to install your Software AG products.
We recommend that you use the SoftwareAG directory as the location for Natural Engineer.
But any other directory is also possible.
You can only install Natural Engineer on a local hard drive on a Windows system. You cannot
install Natural Engineer on a network-mounted drive or a SUBST drive.
Important: It is recommended that you do not install into a directory which is a
subdirectory of a previous installation. Such a previous installation may have been
created either with the Software AG Installer or by an installation tool that was used
in the past.

Side-by-Side Installations
You can install the same Natural Engineer version more than once on the same machine. And
you can also install several different versions of Natural Engineer on the same machine. This
may be necessary to test a new Natural Engineer version before it is taken over into a
production environment. Each version, however, must be installed in a separate directory.
That is, when Natural Engineer is already installed, for example, in the directory SoftwareAG,
you can install a second instance of Natural Engineer, for example, in a directory named
SoftwareAG2.
Since Empower only offers the latest version of Natural and other products, it is
recommended that you create and keep an image of installed Natural versions for possible
later use. Installing from an image rather than downloading it from Empower will usually be
faster, too. For further information, see Using the Software AG Installer.
While Natural Engineer is being installed, it is not possible for another user to install Natural
Engineer on the same machine. A message with the following information will then be shown:
the name of the user who is currently installing Natural Engineer, when this installation has
been started, and into which directory Natural Engineer is currently being installed.
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Upgrading Your Natural Engineer Environment
When one of the first two digits of the version number changes, we consider an installation as
an upgrade installation.
It is not possible to upgrade an existing Natural Engineer Version 8.2 or Natural Engineer
Version 8.3.1 with a Natural Version 8.3.2 or 8.3.3 installation. Any version of Natural
Engineer prior to version 8.3.2 should be uninstalled before installing Natural Engineer
version 8.3.2 or 8.3.3.

Updating Your Natural Engineer Environment
When the first two digits of the version number remain the same and the third or fourth digit
changes, we consider an installation as an update installation.
To update Natural Engineer, specify the same directory and select the same items to install.

Installation
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Installing Natural Engineer

Using the GUI to Install Natural Engineer
This installation documentation provides just a brief description on how to install Natural
Engineer directly on the target machine using the Software AG Installer GUI. For detailed
information on the Software AG Installer, see Using the Software AG Installer.
To install Natural Engineer
Software AG provides one or more license files for Natural Engineer; the installer requires
them during a first-time installation. Copy the license files to the machine on which you want
to install Natural Engineer. You can copy the license files to any temporary location. The
installer will ask for the location of your license file and will then copy them to the common/conf
directory of your installation directory.
1

Start the Software AG Installer GUI as described in Using the Software AG Installer.

2

When the first page of the Software AG Installer GUI (the so-called Welcome panel) is
shown, choose the Next button repeatedly (and specify all required information on the
shown panels as described in Using the Software AG Installer) until the panel containing the
product selection tree appears. This tree lists the products you have licensed and which
can be installed on the operating system of the machine on which you are installing.

3

To install Natural Engineer with all of its product components, expand the Natural
Products node followed by the Application Engineering node and select Natural Engineer.

Note: Products or product versions which are already installed in the selected
installation directory are shown as disabled.
12
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4

Choose the Next button.

5

Read the license agreement, select the check box to agree to the terms of the license
agreement, and choose the Next button.

6

First-time installation only.
Enter the full path to the Natural Engineer license file (or use the Browse button to select it
from a dialog box).
Optionally enter the full path to the Natural Engineer Advanced Services license file and/or
the Natural Engineer Aris Interface license file (or use the Browse button to select it from a
dialog box).

7

Choose the Next button.

8

On the last panel, review the list of products and items you have selected for installation.
If the list is correct, choose the Next button to start the installation process.
When the Software AG Installer has completed the first-time installation, additional
configuration steps are required. See Completing the Installation for further details.
Note: If you wish to use the Aris Interface, and have done an update installation from
NEE832 to NEE833, your Aris Interface license file needs to be renamed to NAI83.xml,
and manually copied to <InstallDir>/common/conf.

Installation
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Using Software Distribution Tools to Install Natural Engineer
You can use the Software AG Installer to create an installation package which can then be
distributed automatically to any number of computers in your environment. You can use any
third-party distribution tool for this purpose.
To distribute Natural Engineer, the following items are required:
■

Software AG Installer.

■

Installer image containing the products to be installed.

■

Script file which defines the location of the image file, the products to be installed, and the
locations of all required license files.

■

License files for the products to be installed.

The description below just provides a brief overview on how to create the required files. For
more detailed information, see Using the Software AG Installer.
To create the image and script
1

Start the Software AG Installer GUI as described in Using the Software AG Installer.

2

On the Welcome panel, choose the Advanced Options button.

3

Go to the Images tab and proceed as follows:
1. Select the Use installation image check box.
2. Select the Create image option button.
3. Specify a location and name for the image. The installer will automatically add the extension
.zip.
4. Specify the platform for which you want to create the image. You can create an image
for any platform from any platform.
5. Choose the OK button to return to the Welcome panel.

4

Choose the Next button repeatedly in order to:
1. Select the products to be installed.
2. Agree to the terms of the license agreement.
3. Start the installation to create the image.
Note: When creating an image, the panels on which you usually specify the license
files and ports do not appear.

5

Start the Software AG Installer GUI once more, and choose the Advanced Options
button again.

6

Go to the Images tab again and proceed as follows:
1. Select the Use installation image check box.
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2. Select the Install from image option button.
3. Specify the name of the image that you have previously created.
7

Go to the Scripts tab and proceed as follows:
1. Select the Use installation script check box.
2. Select the Create script option button.
3. Select the Do not install products on local machine option button, unless you also
want to install on the local machine in the same step.
4. Specify a location and name for the script.
5. Choose the OK button to return to the Welcome panel.

8

Choose the Next button repeatedly in order to:
1. Specify the installation directory.
2. Select the products to be installed.
3. Agree to the terms of the license agreement.
4. First-time installation only: Specify the paths to all required license files and, if
required, specify the ports for the selected products.
5. Start the installation to create the script.
Note: It is recommended that you create separate scripts for first-time
installations and update installations.
To adapt the script

1

Edit the script that you have previously created and adjust the references to the image
and license files. For example:
guiNscLicense= VERSION1 ,C%3A%5CUsers%5Cxyz%5CDocuments%5CLics%5Cnsc83.WinDesk.2013.xml
guiNatLicense= VERSION1 ,C%3A%5CUsers%5Cxyt%5CDocuments%5CLics%5Crun83WinDesk.2013.xml
imageFile=C\:\\Users\\xyz\\Documents\\NaturalSec83.zip

For an automated installation, the references to the image and license files need to be
adjusted to the actual installation location. You can specify either the full path or a
relative path such as file-name, .\\file-name or .\\folder-name\file-name. You can
also specify the full path to a fi server such as \\\\file-server\\folder-name\filename. The following examples show the different ways in which a path can be specified:
guiNscLicense= VERSION1 ,nsc83.WinDesk.2013.xml
guiNscLicense= VERSION1
,.\\Lics\\nsc83.WinDesk.2013.xml
guiNscLicense= VERSION1 ,\\\\Server1\\Lics\\nsc83.WinDesk.2013.xml

You also can use environment variables as part of the path specification. For example:
imageFile=$IMAGEDIR$\\NaturalSec83.zip

Installation
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2

If necessary, adjust the parameter values in the script (for example, port numbers).
Note: You can delete the port specification lines for Natural Development Server
(guiNdvPort=..) and the Natural Web I/O Interface (guiWebioPort=..) from the
script if you want to make sure that the installation does not stop if the specified port
number is in use. In this case, the next free port number will be used.

To start the installation
■

Start the installation from the command line. Start the installer jar file as follows:
java -jar SoftwareAGInstaller.jar -readScript script-file-name ↩
-scriptErrorInteract no

Alternatively, you can use the installer exe file. In this case, you have to set the environment
variable ZFUSION_INSTALL_ARGS to the required installer options:
set ZFUSION_INSTALL_ARGS=-readScript fullpath\script-file-name ↩
-scriptErrorInteract no
SoftwareAGInstaller.exe

Note: An appropriate Java version must be installed on the machine when using
the jar file. A Java installation is not required when using the exe file.
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Operational Considerations

Windows User Group
The Natural installation creates a local Windows user group with the name "SAG Natural
Users". The user "EVERYONE" is assigned to this user group by default.
When the Windows user group "SAG Natural Users" is created, you have to reboot your
machine when the installation finishes. When this user group has already been created (due to
a previous installation), this reboot is not required.
The user group "SAG Natural Users" receives full write permissions for all installed objects.
Due to the user "EVERYONE", all users have write permissions for all installed objects. You
can limit these permissions by removing the user "EVERYONE" from the user group "SAG
Natural Users", and then manually adding all required users to this group. To do so, go to
Control Panel > System and Security > Administrative Tools > Computer Management; in the
resulting window, select Local Users and Groups.

Entries in the Start Menu
Depending on your selection in the product selection tree, some or all of the following entries
have been created in the Windows Start menu:
■

Under All Programs > Software AG > Tools:
Natural Engineer n.n

■

All Programs > Software AG > Documentation

where n.n stands for the current version number. The Start menu group name (by default, this
is "Software AG") can be changed during the installation.

18
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Setting Up Your Products Using the SYSPCI Utility
After you have installed your product, you need to set up a number of files, parameters and
individual settings depending on your environment. These are described below. To set them
up, you use the SYSPCI utility. For detailed information on this utility, see SYSPCI Utility Product Configuration and Initialization in Natural's Tools and Utilities documentation.
Natural Engineer requires an Adabas Repository and Component system file. These may be
local or remotely accessed via a SPoD environment.

When you initialize (activate) Natural Engineer using the SYSPCI utility, the default FNAT
system file from the installation must be used (that is, <install-dir>/Natural/fnat). Otherwise, a
subsequent update installation will not be possible.
For a local Adabas installation:
The database IDs and file numbers of the new or existing files that you specify using the SYSPCI
utility are entered into the default parameter files for Natural Engineer (NEEPARM).
It is recommended for an Adabas database containing Natural Engineer repository or component
files to have a Work Block Size of 16KB.
■

Existing Local File
Before you start the SYSPCI utility, make sure that the Adabas database containing the
required files is active. With this version, you can continue to use your existing files. No
migration of data from the previous version to the current version is necessary.

■

New File
Before you start the SYSPCI utility, make sure that the Adabas database which will contain
the required files is active. The SYSPCI utility will load and initialize these files. This should
be also done if another file is required for your product.

Before you create new files with the SYSPCI utility, make sure that the ASSO and DATA sizes
of your Adabas database are appropriate for these files. It is therefore recommended that you
check the Adabas .fdu files in the <install-dir>/<product>/INSTALL/<product-code>
directory for the used sizes. If required, change your database setup so that the files can be
created.
In addition, make sure that the Adabas nucleus parameters listed in the following table are set for
the database you want to use at database startup. They are not appropriate if you are using the
default nucleus parameters.
LWP

Must be at least 1,000,000.

OPTIONS The option TRUNCATION must be set in the OPTIONS parameter.

Installation
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Invoking the SYSPCI Utility
In order to invoke the SYSPCI utility, you must first invoke Natural. You can then invoke the
SYSPCI utility using the command line.
To invoke the SYSPCI utility
1

From the Windows Start menu, choose All Programs > Software AG > Tools > Natural n.n
to invoke Natural.

2

From the View menu, choose Command Line to switch on the display of the command line.

3

Enter the following command in the command line:
SYSPCI

For more information, see SYSPCI Utility - Product Configuration and Initialization in Natural's
Tools and Utilities documentation.
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Apply Changes to Repository FDT
If you are upgrading from a previous Natural Engineer version and want to re-use your
existing data then the following tasks should be performed where applicable.
Notes:
1. Depending on the version of Natural Engineer used as a starting point, all subsequent
migration steps must be followed. For example: If the starting point is Version 8.2.1 then
migration steps Version 8.2.2, Version 8.2.2.1, Version 8.2.2.2, Version 8.2.3, Version 8.2.3.1,
Version 8.2.3.2, Version 8.3.1 and Version 8.3.2 must be addressed.
If you are upgrading from a version earlier than version 8.2.1 then please refer to the
relevant NEExxx Release Notes documentation.
2. As of Natural Engineer version 8.2.2 the Refactoring Option of Natural Engineer has been
replaced by Advanced Services
From Natural Engineer Version 8.2.1
If you are upgrading from Natural Engineer version 8.2.1 to Natural Engineer version 8.2.2
then there are no conversion tasks to be performed.

From Natural Engineer Version 8.2.2 Base Release
If you are upgrading from Natural Engineer version 8.2.2 to Natural Engineer version 8.2.2.1
you will need to perform the following task:
[i] Release the following Superdescriptor:
SQ= AA(1,8), AZ(1,1), AK(1,32), RC(1,1), AB(1,8)
[ii] Conversion is Complete

From Natural Engineer Version 8.2.2.1
If you are upgrading from Natural Engineer version 8.2.2.1 to Natural Engineer version 8.2.2.2
you will need to perform the following task:
[i] Add the following fields to the end of the REPOSITORY file:
01,NQ,65,A,NU
[ii] Invert the following Superdescriptor:
ST= AA(1,8), AB(1,8), NQ(1,65)
Installation
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[iii] Decompress the Repository file.
[iv] Backup and then delete the existing Repository file.
[v] Compress and Load using the inline definitions in the Job.
[vi] Conversion is Complete
From Natural Engineer Version 8.2.2.2
[i] If you are upgrading from Natural Engineer version 8.2.2.2 to Natural Engineer version
8.2.3 and have JCL loaded into your repository you will need to run the following object in the
SYSNEE library:
NEEJXCNV
Note: This program is completely re-executable and should be executed in a Natural
session invoked using the Natural Parameter file: NEEPARM.
[ii] Conversion is Complete

From Natural Engineer Version 8.2.3 Base Release
[i] If you are upgrading from Natural Engineer version 8.2.3 to Natural Engineer version
8.2.3.1 you will need to run the following object in the SYSNEE library:
NEEEXCNV
Note: This program is completely re-executable and should be executed in a Natural
session invoked using the Natural Parameter file: NEEPARM.
[ii] Conversion is Complete

From Natural Engineer Version 8.2.3.1
[i] If you are upgrading from Natural Engineer version 8.2.3.1 to Natural Engineer version
8.2.3.2 and have COBOL Links defined then you will need to run the following object in the
SYSNEE library:
NEECLCNV
Note: This program is completely re-executable and should be executed in a Natural
session invoked using the Natural Parameter file: NEEPARM.
[ii] Conversion is Complete

22
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From Natural Engineer Version 8.2.3.2
If you are upgrading from Natural Engineer version 8.2.3.2 to Natural Engineer version 8.3.1
you will need to perform the following tasks:
[i] Invert the following Superdescriptors:
SU= AA(1,8), NL(1,1), AN(1,32)
SV= AA(1,8), NL(1,1), OL(1,1), AS(1,1), AN(1,32)
SW= AA(1,8), NL(1,1), OL(1,1), AN(1,32)
If you have soft links within your applications then the following object needs to be needs to
be run to ensure that the soft link records are converted to the new format.
[i] To apply the necessary conversions run the following object in the SYSNEE library
NEESLCNV
Note: This program is completely re-executable and should be executed in a Natural
session invoked using the Natural Parameter file: NEEPARM
[ii] Conversion is Complete

From Natural Engineer Version 8.3.1
If you are upgrading from Natural Engineer version 8.3.1 to Natural Engineer version 8.3.2
then there are no conversion tasks to be performed.
From Natural Engineer Version 8.3.2
If you are upgrading from Natural Engineer version 8.3.2 to Natural Engineer version 8.3.3
then there are no conversion tasks to be performed.

Installation
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Remote Development Environments
Natural Engineer offers compatible support for remote development environments using
Natural's Single Point of Development (SPoD) available with Natural version 6.3.
When using Natural Engineer in a SPoD environment the same version of Natural Engineer
must also be installed in both client and server environments.
Location of the Repository File
It is recommended that the location of the Repository file when utilizing the SPoD environment
for Natural Engineer is in the same location as the NDV server and the Natural Source Code.
■

The Natural Parameter file used to map the remote environment needs to have the
correct settings for LFILE 96 (Repository file).

Mapping the Remote Mainframe Environment
To successfully utilize the SPoD environment for Natural Engineer, Natural parameter settings
need to be made which will be invoked when using the Map Environment function in Natural
version 8.3.
The key parameter settings for Natural Engineer are:
■

LFILE 95
To access the mainframe Natural Engineer Refactoring database file, LFILE 95 needs to be
defined with the required database id and file number.

■

LFILE 96
To access the mainframe Natural Engineer Repository, LFILE 96 needs to be defined with
the required database id and file number.

■

OVSIZE
If you are using an NDV Server that uses CICS Sub-tasks then the OVSIZE parameter
should be set to at least 10000.

■

CFICU=ON,CP=AUTO
To ensure correct display of Natural Source Code when running Natural Engineer in a
SPoD environment to a mainframe server these need to be set.

■

TABA1 (EBCDIC to ASCII Translation Table)
Used to translate any special characters between the mainframe and the PC. For example:
TABA1=(7C,40)
This represents the '@' sign. The EBCDIC value is 7C and the ASCII value is 40.

■

TABA2 (ASCII to EBCDIC Translation Table)
Used to translate any special characters between the PC and the mainframe.
TABA2=(40,7C)
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This represents the '@' sign. The ASCII value is 40 and the EBCDIC value is 7C.
Note: The TABA1 and TABA2 parameters only need to be specified if the standard SPoD translation
tables do not handle all special characters, for example umlauts, tilda sign exclamation mark etc. Any
translation problems that may occur are related to the SPoD environment rather than Natural Engineer.
The parameter settings are applied using the 'Startup Session Parameters' specified in the Map
Environment function within Natural version 6.3.
The session parameters can be defined in one of three ways:
■

As a dynamic individual parameter. For example
LFILE=(00096,11177,01052)

■

As a defined profile using SYSPARM. This would then be referenced using the
'PROFILE=' parameter. For example:
PROFILE=NEESPOD

■

Use the NTSYS macro within NATPARM. This is compiled into the Natural
environment itself and will automatically invoke the correct settings. This would then
be referenced using the 'SYS=' parameter. For example:
SYS=NEESPOD
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Remote Desktop Services
Natural Engineer offers compatible support for environments that make use of Windows
Remote Desktop Services.
Use of Remote Desktop Services provides an easily maintained run time environment with
centrally deployed copies of Adabas, Natural and Natural Engineer residing on a server
machine. Users can log on to this environment and execute Natural Engineer tasks as if
they were running on their own separate machine.
Note: The use of Remote Desktop Services is available to both the Windows and Natural's Single
Point of Development (SPoD) environments.
Configuration
In order to execute Natural Engineer successfully in a Remote Desktop Services
environment the following configuration tasks are required.
Natural Parameter File for Natural Engineer
The Natural Parameter file NEEPARM, used to execute Natural Engineer under Windows,
needs to be modified to include a new environment variable USERNAME in the path
names for each work file referencing the Natural Engineer DATA folder.
The environment variable must have the delimiter character ‘%’ at the start and end of the
variable name, i.e. %USERNAME%.
This will provide each logged on User with their own DATA folder containing the Natural
Engineer files they are working with. This provides User integrity in the shared server
environment.
Example using work file 3 which is used to hold the extracted application data to be loaded
into the Repository:
<install-dir>\NaturalEngineer\data\%USERNAME%\########.OUT

Note: This change is only required on the server machine hosting Natural Engineer. If the default
Natural Parameter file NEEPARM has been renamed or copied, then these modifications need to be
applied to the renamed or copied version.
Natural Engineer INI File
The Natural Engineer initialization file NATENG.INI, used by Natural Engineer, needs to
be modified to include a new environment variable USERNAME in the path names for
each path referencing the Natural Engineer DATA folder.
The environment variable must have the delimiter character ‘%’ at the start and end of the
variable name, i.e. %USERNAME%.
This will provide each logged on User with their own DATA folder containing the Natural
Engineer files they are working with. This provides User integrity in the shared server
Installation
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environment.
Example using the INI parameter “XLS=” which locates the Natural Engineer Excel macro:
XLS=<install-dir>\NaturalEngineer\data\%USERNAME%\XLS\NATENG.XLS

Note: This change is only required on the server machine hosting Natural Engineer.
User DATA Folders
To accommodate the new Natural Engineer User DATA folders, the User folders must first be
created in the Natural Engineer DATA folder.
Example for User = XGSLXX
<install-dir>\NaturalEngineer\data\XGSLXX

Note: This change is only required on the server machine hosting Natural Engineer
The contents of the DATA directory including sub-directories should be copied from
<install-dir>\NaturalEngineer\data
to each individual User folder e.g.,
<install-dir>\NaturalEngineer\data\XGSLXX
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Windows Server Installation
If you wish to run Natural Engineer with Windows clients communicating to a Windows
Server using SPod, then the same release/patch level of Natural Engineer needs to be
installed on all platforms. In addition the BAT files need to be renamed (by removing the
suffix .tpl) and configured on the server to enable Natural Engineer to run certain batch
functions e.g., extract.bat.tpl should be renamed to extract.bat.
For installations under Natural 8.3 the BAT files reside in
<install-dir>\NaturalEngineer\Bat\

If you have an existing installation then the supplied BAT files templates should be
checked and any changes applied to your existing BAT files.
The BAT files are also utilised by the Bulk Extract & Load function. If wish to run the Bulk
Extract & Load functionality and are running purely on the PC or in a Windows Server
environment then the relevant BAT files need to be configured.
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Natural Parameter Settings
The Natural parameter settings are independent of the number of lines of code being
processed. In fact, Natural Engineer does not require the settings listed below. However, for
optimum performance they are the recommended minimum set for any Natural Engineer
session. The following parameters are relevant for Natural on the PC platforms.
Parameter

Setting

Comment

BPSIZE

2000K

Set at least a 2MB Bufferpool.

BPSFI

ON

Set BPSFI on.

ZD

OFF

Set as ZD=off.
Note: Prevents NAT1302 error during the Load process.

EDTBPSIZE

600K

If you have a installation of Predict 8.2.2 (or above) under
Windows please set the EDTBPSIZE parameter to at least
600K. This is to ensure that COBOL programs accessing
Predict User Views are handled by the Predict User Exits
correctly.

Other Natural Parameter settings have to be set for Natural Engineer such as LFILE 96. This
depends on what Repository (DBID, FNR) has been created.
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Environment Sizing
This section describes the environment sizing considerations based on one million lines of
source code.
Hard Disk Space
Natural Engineer writes an Extract file (“application name”.OUT) which contains the neutral
records for loading into the Natural Engineer Repository.
■

For the PC platforms, 1 million lines of code require 300 Meg of hard disk space.

■

For the MVS platform, 1 million lines of code require 300 cylinders of disk space. This
file can also be written to tape.

Adabas Database
Space Requirements

The main consideration when estimating space requirements for Natural Engineer depends
upon the complexity of the code, for example how many include routines are present (LDAs,
GDAs, PDAs, COPYCODEs etc). The more include routines, the larger the Repository size.
An average record size is 200 bytes.
For 1 million lines of code and more, this would equate to the following:
Natural Studio

Mainframe

Adabas on Windows

3390

3380

ASSO

220 MB

200 cyls

300 cyls

DATA

250 MB

600 cyls

900 cyls

WORK

50 MB

100 cyls

100 cyls
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Alternative Natural Keywords
This section describes the ability to add alternative Natural keywords to Natural Engineer.
Overview
If your site makes use of any alternative Natural keywords that you have modified to the
Natural NATTEXT module, then Natural Engineer will not recognize these as valid
Natural keywords during the Extract process. This could result in Natural Engineer
having an incomplete representation of your applications.
As with Natural, it is possible to add any alternative Natural keywords to Natural
Engineer to resolve this issue.
The NATSTT-T Text Member
The alternative Natural keywords can be added to the text member NATSTT-T, which
can be found on the FNAT library SYSNEE.
The new keywords should be added to the end of the text member NATSTT-T. Each
keyword needs to be added as a new row within the text member NATSTT-T.
The following table illustrates the format and positioning of the NATSTT-T entries:

32

Column Positions

Description

01-32

The name of the alternative keyword.

33

Not required. Should be blank.

34

Indicates whether the alternative keyword is a keyword or not.
Valid values are:
X - Not a keyword in its own right.
Y - Is a keyword in its own right.

35

Indicates whether the alternative keyword has a further
qualifier.
Valid values are:
‘ ‘ - No further qualifier.
Y - A further qualifier is available and needs to be checked for.

36-38

Not required. Should be blank.

39

Indicates that the keyword is an alias of another keyword.
Valid values are:
A - Alias.

40-71

The name of the Natural keyword that is being aliased.
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Example
This example illustrates how the text member NATSTT-T is modified for the following criteria:
■

ADDNEW is a new keyword that is an alias for the Natural keyword STORE but is not a
keyword in its own right. It uses a further qualifier of ADDNEW X. This means that for
STORE statements the alternative keyword ADDNEW X is used.

■

CHANGE is a new keyword that is an alias for the Natural keyword UPDATE and is a
keyword in its own right. It has no further qualifier. This means that for UPDATE
statements the alternative keyword CHANGE is used.

■

PURGE is a new keyword that is an alias for the Natural keyword DELETE and is a
keyword in its own right. It also uses a further qualifier of PURGE X. This means that
for DELETE statements the alternative keyword PURGE or PURGE X is used.
ADDNEW
ADDNEW X
CHANGE
PURGE
PURGE X

XY
Y
Y
YY
Y

ASTORE
ASTORE
AUPDATE
ADELETE
ADELETE

Note: If you have added any alternative keywords, it is recommended that you review the contents of the
text member NATSTT-T after any new installation of Natural Engineer. If necessary you may have to
re-apply your changes.
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Natural Engineer User Exits
Natural Engineer offers compatible support for remote development environments using
Natural's Single Point of Development (SPoD) available with Natural version 6.3.
Natural Engineer User Exits
Natural Engineer provides various user exits. They are:
NEEUEX1 - Application Lock Password Setting (Mainframe and Unix Only)
NEEUEX1 is used if you wish to change the Application Lock Release Password
from the default value. The new value must be uppercase and contain no special
characters.
NEEUEX2 - Mainframe Job Submission (Mainframe Only)
This is used to customize RJE online job submission.
NEEUEX3 - User Customizable Modification
NEEUEX3 is used in modification. Each source line to be modified will be passed to
this exit. The user may then perform any customizations on the source prior to the
modification being actually applied.
NEEUEX4 - Natural for Ajax Adapter Name Generation
NEEUEX4 allows the dynamic generation of adapter and variable names in the
Natural for Ajax processing.
NEEUEX5 - Generate Application Names (PC Only)
NEEUEX5 allows for the dynamic generation of application names within Natural
Engineer.
NEEUEX6 - Bespoke Security Interface
NEEUEX6 controls access to applications when Natural Security does not exist.
Further information on the usage of these user exits are contained within the source of the user
exits themselves on the SYSNEE FNAT library.
Notes:
1: The user exit modules are supplied named ‘NEEUEXnX’ where 'n' in the number of the User
Exit, on the Natural Engineer SYSNEE library. This is to avoid overwriting any existing
(modified) versions on the production SYSNEE library during Natural Engineer installation. If
this user exit has not been loaded before, then it will need to be renamed to ‘NEEUEXn’ i.e.,
NEEUEX2 before making use of the User Exit functionality.
2: NEEUEX5 and NEEUEX6 are required on the PC. If they don't exist the NEEUEX5X object
will need to be renamed to NEEUEX5 and the NEEUEX6X to NEEUEX6 before any Natural
Engineer Applications can be created.
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Natural User Exits
Natural Engineer utilizes various Natural user exits. These need to be made available to the
Natural session where you are running Natural Engineer.
USR4206N
USR4209N
USR6006N
USR6203N
If you are using the Natural Engineer Web Interface then the following Natural user exits also
needs to be made available.
USR1005N
USR1007N
USR1019N
USR1054N
USR2018N
USR2026N
USR3013N
Note: The supplied Natural Engineer NATPARM module specifies SYSEXT as a steplib so they should
be picked up automatically.

Generation of Reports to PDF
Natural Engineer outputs reports into various formats e.g., Word, a spreadsheet e.g., Excel and
HTML. If you wish to generate reports into PDF then a third-party Formatting Objects
Processor e.g., Apache FOP and the Microsoft Command Line Transformation Utility
(MSXSL.EXE) will need to be installed. Install both into the same directory.
Following the installation of the FOP utility and MSXSL.EXE the transformfo.bat and fopexe.bat
BAT files need to be renamed (by removing the word SAMPLE) and configured to point to the
directory where the objects have been installed.
In addition the PDF= parameter in the [REPORTER] section of the NATENG.INI file needs to be
set to Y.
The latest version of Apache FOP may be downloaded from http://xmlgraphics.apache.org/fop/
Microsoft Command Line Transformation Utility (MSXSL.EXE) may be downloaded from
http://www.microsoft.com/en-gb/download/details.aspx?id=21714.
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Users of East Asian Languages (Double Byte Character Sets)
If a user is having difficulties displaying details on the nodes within Natural Engineer, it may
be related to character differences between windows locale. To resolve the
NEETV_RECORD_DELIM setting in the [ENVIRONMENT] section of the Initialization file
should be changed from the default ¬ (Logical not).
Possible values cannot be a valid character that may be used in a Natural application name
or field name, vertical bar or a tilde. For Chinese(Hong Kong) or Japanese, for example, this
should be set to a semi-colon e.g.,
[ENVIRONMENT]
NEETV_RECORD_DELIM=;
In addition, to display characters correctly in reports that go to WORD the user must set
the correct ISO setting for their environment in the NATENG.INI file in the
[ENVIRONMENT] section e.g., for Japanese
[ENVIRONMENT]
ISO-WORD=ISO-2022-JP
To display characters correctly in PDF output a different encoding may be required as the
MSXML processing that underpins the PDF generation utilizes different character
encoding. Therefore a separate NATENG.INI setting is required for this e.g., for Japanese
[ENVIRONMENT]
ISO-PDF=SHIFT-JIS
More information may be found at the following link.
http://msdn.microsoft.com/en-us/library/windows/desktop/ms757065%28v=vs.85%29.aspx
If you wish to export comma delimited files to Microsoft Excel e.g., from Literal &
Constant Search Export functionality then the Editing Language in Microsoft Excel must be
set to a language that supports DBCS e.g., Japanese. In Microsoft Excel 2010 this may be
achieved by choosing "Options" from the "File" menu and then "Language",
"Choose Editing Languages" and selecting "Japanese" as the default Editing Language.
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Install IIE Directory
This section describes the location and contents of the NEA installation directory.
The files by default will be installed to
<install-dir>\NaturalEngineer\Nea

Four subdirectories are associated with the NEEGUI.
■
■
■
■
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IIE contains the application code.
NAS contains the application server.
WEB contains the modules when using a web server.
CACHE contains caching options.

Installation

Natural Engineer Web Interface

Post Installation Configuration
This section describes the post installation configuration tasks that are required to the
Natural components of the NEA installation. This is applicable to both single and multiuser modes. The Natural Objects to run the Natural Engineer Web Interface will have
been loaded into the SYSNEEI library during the normal Natural Engineer Installation.
Initialization Routines
There are three supplied initialization routines in SYSNEEI library: INIMF-NX, INIPCNX and INIUX-NX. If this is a new installation, rename these objects to INIMF-N,
INIPC-N and INIUX-N respectively and amend the entries to match your environment.
If this is an existing installation, check parameters in INIMF-NX, INIPC-NX and INIUXNX and see if they need transferring to existing objects.
If running on a mainframe environment any Application Properties that are set within
Natural Engineer for COBOL and JCL directory locations will override the SOURCEDIR, COPY-DIR and MAP-DIR settings within the initialization routine.
Settings
Group Header / Parameter

Description

##COBOL-SECTION
SOURCE-DIR
SOURCE-EXTNS

The full directory name where the COBOL Source
members are located.
The suffixs of the COBOL Source members.
Default = ,COB,CBL,CCP
NB: The initial , (comma) means also check for
members with no suffix.

COPY-DIR

The full directory name where the COBOL Copycode
members are located.

COPY-EXTNS

The suffixs of the COBOL Copycode members.
Default = ,CPY, COP
NB: The initial , (comma) means also check for
members with no suffix.

MAP-DIR

The full directory name where the COBOL Map
members are located.

MAP-EXTNS

The suffixs of the COBOL Map members.
Default = ,BMS
NB: The initial , (comma) means also check for
members with no suffix.

NB: COBOL only applicable to PC (INIPC-N) and Mainframe(INIMF-N)

##JCL-SECTION
SOURCE-DIR
SOURCE-EXTNS

Installation

The full directory name where the JCL Source
members are located.
The suffixs of the JCL Source members.
Default = ,JCL
NB: The initial , (comma) means also check for
members with no suffix.
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Group Header / Parameter

Description

COPY-DIR

The full directory name where the JCL Copycode
members are located.

COPY-EXTNS

The suffixs of the JCL Copycode members.
Default = ,PRC
NB: The initial , (comma) means also check for
members with no suffix.

PROCLIB-DIR

The full directory name where the JCL Procedures are
located.

PROCLIB-EXTNS

The suffixs of the JCL Procedures.
Default = ,PRC
NB: The initial , (comma) means also check for
members with no suffix.

NB: JCL only applicable to PC (INIPC-N) and Mainframe(INIMF-N)
##APPS-SECTION
XAPPS

List of Applications to be excluded from being
shown.
Applications to be excluded are specified delimited
by a comma’
Default = ‘ ‘

NCST

Show Natural Construct generated modules i.e., those
prefixed CC*, CD*.
Default = ‘Y’
Valid values = ‘Y’ , ‘N’

OBJ-GROUP-MAX

Maximum number of objects to be shown per Object
group.
Default = ‘1000’

OBJ-COMMENTS

Show Object Comments when hovering.
Default = ‘Y’
Valid values = ‘Y’, ‘N’

XREF-LEVEL-MAX

The amount of levels to drill down to for
showAppMapXref and showAppXref functions.

LISTSEP

Override the separator character when exporting data
in CSV format.
Default = Natural’s ID character as set in the
NATPARM module being used in your Natural
session.

CODEPAGE

The name of the codepage to be used.
Default = ‘ ‘
Valid values = ‘codepagename’, SYSTEM,ON
‘codepagename’ = use specified codepage source but
source codepage overrides.
SYSTEM = use *CODEPAGE setting to encode all
source but source codepage overrides *CODEPAGE.
ON = only encode any source with a codepage set.
NB: This is used in conjunction with the settings in
the mainframe Natural Parameter module.

##RPC-SECTION
BUFSIZE
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The Buffer size for RPC.
Default = ‘ ‘ (will be set internally to 30K)
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##TRACE-SECTION
TRACE

Internal debug setting to set Tracing on.
Default = ‘ ‘
Valid values = ‘Y’ , ‘ ‘
Only to be used when requested by Support
personnel.

FILE

Internal debug setting to specify location of Trace
file.
Only to be used when requested by Support
personnel.

LEVEL

Internal debug setting to specify Trace Level.
Only to be used when requested by Support
personnel.

##REQUESTS-SECTION
LISTLITERALSLIMIT

Limits the amount of records retrieved by the LIST
LITERALS Report.
Default = ‘5000’

LISTMAPSHOWMESSAGESAUTO

If set to ‘Y’ any REINPUT type messages will
automatically be shown when a map is displayed. I
set to ‘N’ the identification of these messages will be
controlled by a button.
Default = ‘N’.
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Natural Parameter Modules
If this is a new installation you will need to create a Natural Parameter module for the
NEA interface. The following steps should be followed to achieve this.
1. Using the Natural Configuration utility save a copy of the NEEPARM
parameter file as NEEGUI
2. Modify the NEEGUI parameter module as follows:
i. Natural Execution Configuration - System Variables
1.
2.
3.
4.
5.
6.
7.

Check the Automatic logon checkbox.
Change the startup library (INIT-LIB) to be SYSNEEI.
Remove the Startup program (STARTUP).
Add SYSNEE to the steplib list.
Move SYSNEE to the top of the steplib list.
Remove all work file entries.
If using codepages set Regional Settings
CP= codepagename.
CPCVERR=OFF.

3. Save the parameter file NEEGUI.
Mainframe Natural Parameter Module
1. Natural Execution Configuration – Regional Settings (if using codepages)
i.
ii.
iii.

CFICU=ON
CP= codepagename.
CPCVERR=OFF.

If using codepages then the CODEPAGE setting in the mainframe initialization routine (INIMFN) will need to be set also.
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NEA Server (NAS) Installation
This section describes the installation of the NEA Server (NAS). This is used if the
Natural Engineer Web Interface is running in local mode (on one PC) or may be used in
multi-user mode with a web-server instead of EntireX.
Windows
1. Update NAS.INI file to match your directory structure used, default is
<install-dir>\NaturalEngineer\Nea

If using Natural Security
[NEE]
NATLIB=SYSNEEI,userid,password

Where userid and password are the userid and password defined to Natural Security for
the NEA Server.
With Natural Security (either AUTO=ON or AUTO=OFF) ensure that SYSNEE is a STEPLIB
for library SYSNEEI. It is recommended to make SYSNEE and SYSNEEI libraries not protected.
If caching is required then the following settings need to be modified;
[CACHE]
CACHE=Y
DIR= Set to a valid location
[NAS]
CACHE-CONTROL=no-store,no-cache

2. NEA uses port number 19999 by default, (PORT= setting in [NAS] section of the
NAS.INI). If you need to change this then you must also change the CONFIG.js file in the
<install-dir>\NaturalEngineer\Nea\IIE\config subdirectory.
3. Update NATURAL.BAT file to match your Natural environment. This will include the
name of the directory Natural executes from and the NATPARM module created (default
NEEGUI).
4. Start NAS.EXE and a command window will appear.
NB: If you are running in a Windows 7 environment then you will need to ensure that the
NAS.EXE is “Run as Administrator”.
5. Start Web Interface by executing <install-dir>\NaturalEngineer\Nea\IIE\iie.html
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Mainframe (z/OS)
On the NEEvrs.JOBS dataset you will find a member called NEASERV which contains a
sample for running the Natural Engineer Access (NEA) server. It references two
members from the NEEvrs.SRCE dataset:


NEAPARM
Contains parameters controlling Natural Sessions that will be activated by the
NEA server.



NEAINI
Initialization settings controlling the NEA server.

Customizing NEAPARM
Modify the NEAPARM module used for the NEA (NAS) Server as follows:
1. If you are running with Natural Security with AUTO=OFF you will need:
IM=D,AUTO=OFF
2. Set the LFILE setting for LFILE 96 to be the Natural Engineer Repository file.
3. Ensure DBCLOSE setting is set ON.

Customizing NEAINI
Modify the NEAINI module:
1. If you are running with Natural Security with AUTO=OFF you will need:
[NEE]
NATLIB=SYSNEEI,userid,password

2. Check the following setting points to the NEEvrs.SRCE dataset as set in your
environment:
[NAS]
WEBROOT= NEEvrs.SRCE

NOTE: With Natural Security (either AUTO=ON or AUTO=OFF) ensure that SYSNEE is a
STEPLIB for library SYSNEEI. It is recommended to make SYSNEE and SYSNEEI libraries not
protected.
It is recommended to start the NEA server as a started task as it will wait to process
requests from NEE Web clients. To shutdown the NEA Server a member NEASERVC
may be utilized. This is located on the NEEvrs.JOBS dataset.
NB: ADARUN needs to be linked REUS if the mainframe NEA server is to be used.
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Unix
1. Update NAS.INI file to match your directory structure used, default is
<install-dir>/NaturalEngineer/Nea/NAS

If you are using compression (the default) then the relevant ZLIB package for your
Unix operating system will need to be installed. The zlib= setting in the NAS.INI
needs to be set for your operating system.
NOTE: If the ZLIB package is installed into a non-default directory then the LIBPATH
environment variable will need to be changed accordingly.
If caching is required then the following settings need to be modified;
[CACHE]
CACHE=Y
DIR= Set to a valid location
[NAS]
CACHE-CONTROL=no-store,no-cache

2. Update natural.sh file to match your Natural environment. This will include the
name of the directory Natural executes from and the NATPARM module created
(default NEEGUI).
3.

Installation
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Web Server Backend
This section describes the configuration of the Web Server backend. This is only
necessary if you are running the Natural Engineer Web Interface in multi-user mode.
The user may use EntireX or a NAS server if EntireX is unavailable.
1) Copy the following files from the WEB directory to the 'scripts' directory of the web
server for IIS, or ‘cgi-bin’ for Apache: IIE.EXE, IIE.INI
2) Update IIE.INI as required to match your environment
i) If using EntireX change the following;
[NEE]
DRIVER=RPC
[RPC]
BROKER=name of broker executing:port number
SERVER=NEERPC
NATLIB=SYSNEEI
TIMEOUT=600
USERID= broker userid
PASSWORD=broker password

NOTE: If no USERID/PASSWORD supplied will default to IIEUSER/IIEPASS.
SECURITY=
calls)

(if

set

to

Y

set

kernel

security

to

Y

in

ACI

If using Natural Security with EntireX configuration:
SUSERID=
SPASSWORD=

(userid of RPC Server jobs)
(password of RPC Server jobs)

NOTE: With Natural Security (either AUTO=ON or AUTO=OFF) ensure that SYSNEE
is a STEPLIB for library SYSNEEI. It is recommended to make SYSNEE and SYSNEEI
libraries not protected.
NOTE: If using EntireX then the tasks in the EntireX Configuration section will also need
to be followed.
b) If using NAS change the following;
[NEE]
DRIVER=NAS ,
[NAS]
HOST=IP Address or host name of the machine that NAS is running
on.

If EntireX or EntireX mini runtime is not installed on the machine NAS is executing
on then rename iie.exe to be iieold.exe and rename iienas.exe to be iie.exe.
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c) Review the CACHE settings;
[CACHE]
CACHE=Y
DIR= C:\inetpub\wwwroot\IIE\cache

Setting CACHE=Y means that requests accessed via the webserver will store the
results in the directory specified.
NOTE: Set the permissions to allow WRITE access for all users to this directory. Any other
clients accessing the same request via the webserver will not require the request to execute
again but be resolved by the webserver.
Any changes in applications loaded in the Natural Engineer repository will mean the
cache files for the application must be removed to access the most up to date
information.
If webserver caching is set on then the CACHE-CONTROL setting needs to be
changed to turn off client caching and the LAST-MODIFIED setting needs to be
commented out.
[IIE]
CACHE-CONTROL=no-cache,no-store
; LAST-MODIFIED=Thu, 01 Jan 2009 01:00:00 GMT

Clients can view the cache file by the option “listCache” under “Site” on the tree
view. A batch process is available to list, delete and add caching entries. The modules
are in the CACHE dir under NEA.
A cache.bat file is provided to execute the cache module, examples of the input
parameters are contained in the top of the file.
Parameter values are listed below:
1. Option – the option required
Parameter name -opt Possible values (list, del, add)
2. Output – optional output file for messages
Optional output file for messages from the processing
3. Application – application name options
Parameter name
-app
Possible values ( appname, appname …. Or * for all)
Parameter name
-alvl
Reports produced, values (a – application reports, o
- object reports, f – field reports)
Parameter name
-gbl
Global reports, values (y – site reports and other
object types loaded on tree view)

Installation

47

Natural Engineer Web Interface
Examples
1. Process COBJCLNT application accessed on web server and cache object level
reports and log output messages
cache.exe -opt add -url http://mywebsite/scripts/iie.exe -app COBJCLNT -alvl o out C:\temp\neacache.txt
2. Delete COBJCLNT cached objects
cache.exe -opt del -url http://mywebsite/scripts/iie.exe -app COBJCLNT
3. List COBJCLNT objects
cache.exe -opt list -url http://mywebsite/scripts/iie.exe -app COBJCLNT
3) Copy the IIE directory to the WEBROOT directory of the webserver e.g.,
c:\inetpub\wwwroot.
4) Change CONFIG.JS in the IIE\CONFIG sub directory (normally located in
c:\inetpub\wwwroot\iie\config\) so that the web server is selected e.g.,
// Web Server (default)
NAS_SERVER
= "/scripts/iie.exe";
RUN_MODE
= 'S';

5) Microsoft® Silverlight® introduces two new file extensions and thus need to add
the MIME types for those file extensions to your web server so that it recognizes
Silverlight® content appropriately. MIME types you need to add to the server
configuration
.xaml
.xap

application/xaml+xml
application/x-silverlight-app

6) Command to execute the NEEGUI via web server is ‘http://hostname/iie/iie.html’
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EntireX Configuration
This section describes the configuration of Entire X, if required. Only if using a web
server.
1) Add an entry to the Broker attributes file:
Typical setting:
DEFAULTS = SERVICE
CONV-LIMIT
CONV-NONACT
LONG-BUFFER-LIMIT
NOTIFY-EOC
SERVER-NONACT
SHORT-BUFFER-LIMIT
CONVERSION

=
=
=
=
=
=
=

UNLIM
20M
UNLIM
YES
5M
UNLIM
(SAGTRPC,OPTION=SUBSTITUTE)

CLASS=RPC,SERVER=NEERPC,SERVICE=CALLNAT
2) Create new NATPARM module NEERPC with the same entries as NEEGUI
3) Update the NEERPC module to include RPC entries, add to RPC Server tag the
following: Start session as RPC server activated, Server name is NEERPC, Server
node is the Broker name used.

Typical Settings:
DBID=200,
FNAT=(200,7),
FUSER=(200,50),
FDIC=(200,60),
LFILE=(96,200,96),
CFICU=ON,CP=AUTO,
STACK=(LOGON SYSNEEI),
STEPLIB=SYSNEE,
RPC=(SERVER=ON,RPCSIZE=256,MAXBUFF=252,SRVNAME=NEERPC,NTASKS=(1,5),
SRVNODE=broker-name,TIMEOUT=20,TRACE=2,CPRPC=IBM01140)

If the Remote Procedure Call (RPC) server is located on the mainframe (z/OS) there is
a sample JCL in NEEvrs.SRCE(NEARPC). This uses a member from the
NEEvrs.SRCE dataset:
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NEARPC
 Contains sample RPC parameters and the user should amend the following:

LFILE 96

Point to the NEE repository file.

SRVNAME

Name of Broker Service

SRVNODE

Name of Broker instance
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EntireX MiniRuntime
You will need to ensure that the Web Server has access to the EntireXMiniRunTime 32 bit
environment.
EntireXMiniRunTime_x32.EXE should be executed on the Web Server.
Once installed, you should copy erx.dll from “C:\Program Files (x86)\Common Files\Software
AG” to the “scripts” directory (normally c:\inetpub\scripts when using IIS).
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Microsoft IIS Configuration
If you are using a Microsoft IIS Webserver then the following steps will need to be
performed:
1) Install CGIModule Handler Mapping
Add the Module for CgiModule for the ‗Default Web Site‘ and ensure that it is
enabled.
Note: If not present, select ‘Add Managed Modules’ and select
‘System.Web.Handlers.ScriptModule, System.Web.Extensions’ giving it a name such as
CGIModule.
2) Configure Microsoft IIS directories
Add the required Active Virtual Directory for the ‘Default Web Site‘ e.g.,
C:\inetpub\scripts ensuring that the Execute Permissions are set to “Scripts and
Executables”.
The following figure shows sample settings for Microsoft IIS v6.
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3) If using IIS v7, add script map for IIE Executable
Select the default web site and then select ‗Handler Mappings‘
Select ‗Add Script Map…‘ and set
Request Path = iie.exe
Executable = C:\inetpub\scripts\iie.exe
Name = IIE
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Additional Information
This section describes any additional considerations and information pertaining to the
NEA Installation.
Predict Access
1) If you have information in Predict you can view file and field information in NEE by
connecting your FDIC file to the NEEGUI parameter module.
Execution Commands

Multi-User Mode
The following commands may be input to invoke particular functions of NEA via the
web server.
Function
NEEGUI
ONLINE Help
Book
Overview

Command
http://hostname/iie/iie.html
http://hostname/iie/help.html
http://hostname/iie/book.html

Single-User Mode
The following commands may be input to invoke particular functions of NEA directly
on the users machine.
Function
NEEGUI
ONLINE Help
Book
Overview

Command
<install-dir>\NaturalEngineer\Nea\IIE\iie.html
<install-dir>\NaturalEngineer\Nea\IIE\help.html
<install-dir>\NaturalEngineer\Nea\IIE\book.html

Single-User Mode with Microsoft Internet Explorer(IE)
If you are using Microsoft Internet Explorer the following command may be input
instead of the standard NEEGUI command to invoke the NEEGUI directly on the users
machine using the IE application software.
Function
NEEGUI

Command
<install-dir>\NaturalEngineer\Nea\IIE\iie.hta

Test Connectivity outside of Web Browser
To test connectivity without using the Web Server, within a command prompt, go to the
scripts directory & type:
iie.exe NEE?listEnv

This will issue a call direct to the EntireX & RPC Servers.
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The output should be similar to the following:

54

Installation

8

Uninstalling Natural Engineer

You uninstall Natural Engineer Version 8.3.3 using the Software AG Uninstaller. For detailed
information on how to use the uninstaller, see the Using the Software AG Installer guide.
In short, you uninstall Natural Engineer using the standard uninstall functionality of the
Windows. The Control Panel offers the following entry: Software AG Products: <installationdirectory>.
When you choose to uninstall this entry, the Software AG Uninstaller is invoked.
If you uninstall Natural Engineer please re-boot your system before using Natural.
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